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Poznamka pre pouzZivatel'ov systému Mac

Niektoré klavesové skratky a polozky ponuky su v systéme Mac iné ako v systémoch Windows
a Linux. V nasledujucej tabulke sa nachadzaju najdélezZitejSie rozdiely, ktoré sa vztahuju na
informacie v tejto prirucke. PodrobnejSi zoznam sa nachadza v Pomocnikovi aplikacie.

Windows alebo Ekvivalent pre Mac Ué&inok

Linux

Nastroje > LibreOffice > Nastavenia Otvori nastavenia s moznostami
MozZnosti

Pravé kliknutie Control+kliknutie alalebo Otvori sa kontextova ponuka

pravé kliknutie v zavislosti na
nastaveni pocitaca

Ctrl (Control) 3 (Command) Pouziva sa s inymi klavesmi
F5 Shift+3&+F5 Otvori sa Navigator
Fi1 F+T Otvori sa okno Styly a formatovanie
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Co je Impress?

Impress je sucast balika LibreOffice, ktora slizi na tvorbu prezentacii. Pomocou neho mdézeme
vytvarat’ snimky, ktoré obsahuju vela réznych prvkov, vratane textu, odrdzok a €Cislovani, tabuliek,
grafov, klip arty, a Sirokého rozsahu grafickych objektov. Impress tiez obsahuje nastroj na kontrolu
pravopisu, synonymicky slovnik, predpripravené Styly textu a Styly pozadia.

Tato kapitola obsahuje pokyny, snimky obrazoviek a rady, ktoré poslizia ako sprievodca
prostredim programu Impress pri vytvarani prezentacii. Niektoré naro¢nejSie postupy su v tejto
kapitole len spomenuté, detaily vSak mézeme ndjst knihe Navod na pouZivanie programu Impress
(Impress Guide). Pouzivatelom so skldsenostami s tvorbou prezentacii odpord¢ame, aby ako zdroj
informacii pouzili knihu Navod na pouZivanie programu Impress (Impress Guide).

Ked chceme Impress pouZit' na viac ako len na velmi jednoduché prezentécie, potrebujeme vediet
viac o prvkoch, ktoré prezentacie obsahuju. Snimky obsahujlce text pouZzivaju Styly, ktoré urcuju
jeho vzhlad. Vytvaranie kresieb v programe Impress je rovnaké ako v programe Draw. Z tohto
dévodu odporucame preStudovanie kapitoly 3, PouZivame Styly a Sablony a kapitoly 7, ZaCiname
s programom Draw. Podrobnosti o vytvarani kresieb sa tiez nachadzaju v knihe Navod na
pouZivanie programu Draw (Draw Guide).

Spustenie programu Impress

Program Impress je mozné spustit’ niekolkymi spdsobmi:
* Pomocou Spustacieho centra LibreOffice, ak nie je otvorena Ziadna sucast, kliknutim na
ikonu Prezentacia.

* Pomocou systémovej ponuky, z ktorej sa spusta vacsina aplikacii. V systéme Windows je
to ponuka Start. V grafickom prostredi GNOME je to ponuka Aplikécie. V prostredi KDE je
ponuka oznacena logom KDE. V systéme Mac OS X je to ponuka Aplikacie. Postup zalezi
na opera¢nom systéme. Viac informacii sa nachadza v kapitole 1, Predstavujeme
LibreOffice.

* V systéme Windows mézeme zvolit poloZku prezentacia v programe LibreOffice
Quickstarter. Podobné funkcia existuje aj pre systémy Mac a Linux, o com viac najdeme
v kapitole 1, Predstavujeme LibreOffice.

* Pomocou ktorejkolvek otvorenej sucasti LibreOffice. V hlavhom paneli nastrojov klikneme
na trojuholnik vpravo pri ikone Novy a v kontextovej ponuke zvolime Prezentacia, alebo
v hlavnej ponuke zvolime poloZzku Sabor > Novy > Prezentacia.

Ked je balik LibreOffice nainStalovany v pocitaci, vo vacsine pripadov sa

v systémovej ponuke nachadza polozka pre spustenie kazdej jeho sucasti. Presny
n&zov a umiestnenie tychto poloZiek z4visi na operachom systéme a na grafickom
pouzivatel'skom rozhrani.

Poznamka

Ked Impress spustame po prvykrat, zobrazi sa Sprievodca prezentaciou. V iom mdZeme zvolit
jednu z nasledujicich moznosti:

* Prazdna prezentacia vytvori prdzdny dokument

* Otvorit’ zo Sablény vytvori prezentaciu na zaklade vybranej Sablény

e Otvorit’ existujucu prezentaciu

¢ Kliknutim na tlacidlo Vytvorit’ sa otvori hlavné okno programu Impress.

PodrobnejSie informécie o pouzivani sprievodcu prezentaciou sa nachadzaju v ¢asti ,Vytvorenie
novej prezentécie" na strane 15.

Spustenie programu Impress 6



Ak nechceme v buducnosti sprievodcu pouzivat, mézeme zaSkrtnut volbu Tohto sprievodc

u

nabuduce nezobrazovat'. Sprievodcu m6ézeme opat povolit' v hlavnej ponuke zvolenim Nastroje
> Moznosti > LibreOffice Impress > VSeobecné > Novy dokument, kde zaSkrtneme moznost’

Zacat' sprievodcom.

Hlavné okno programu Impress

Hlavné okno programu Impress (obrazok 1) ma tri Casti: Panel Snimky, pracovny priestor a

postranny panel. Okrem nich je mozné pocas vytvarania prezentacie zobrazit alebo skryt' niektoré

dalSie panely nastrojov.

El Bez_mazvu 1 - Libredffice Impross

1 ¥ = RozloFenia

Kliknat na vioZenie nadpisu | =

Kliknit na vioZenie lextu .
Panel l | |
Snimky ]

€ *

Sibor Upravit® Zobrazit® Viedit Format Nastroje Prezentacia Okno  Pomoconik - -+

P EH-B-H = B & W g - ik 25 - @ MR- @ fE-FE-@E

P VBB [ S5~ |0,00cm -Tango;ntv. A Farba ~| v| = 3

Snimbky x| Marmdlne Dsnova Poznamky Podklady Zoradoval snimok | Viastnosti X
F

Pracovny priestor Postranny panel

= 29,78 / 5,01 X 0,00 x 0,00 :  Snimka 1/ 1| Predvolené | - -o——i + | 25%

Obréazok 1: Hlavné okno programu Impress; ovalmi su zvyraznené manipulatory na
zobrazenie/ skryvanie panelov

Panely Snimky a Postranny panel je mozné zatvorit kliknutim na X v ich pravom

hornom rohu alebo zruSenim zaSkrtnutia pri poloZkach Zobrazit’ > Panel Snimky
alebo Zobrazit' > Postranny panel v hlavnej ponuke. Opéatovne ich otvorime tak, Ze

v hlavnej ponuke zvolime Zobrazit' > Panel Snimky alebo Postranny panel.

Pracovny priestor mbZzeme zvacsit na cell plochu okna aj tak, Ze klikneme na
manipulatory v strede zvislého oddelovaca na jeho stranach (zvyraznené na

Tip

obrazku 1). Pouzitim manipulatorov sa panely Snimky a Postranny panel len skryja,

nezatvoria sa. Opéatovne ich zobrazime kliknutim na manipulator.

Hlavné okno programu Impress



Panel Snimky

Panel Snimky obsahuje miniatlry snimok prezentécie v poradi, v akom sa budu zobrazovat (ak
poradie zobrazovania nezmenime). Kliknutim na miniatdru na tomto paneli snimku vyberieme a
stcasne ju umiestnime do pracovného priestoru. Ked je snimka v pracovnom priestore, mdézeme
na nej vykonavat poZzadované zmeny.

Niektoré operacie mozno v paneli Snimky vykonavat na jednom alebo viacerych snimkach
sucasne:
* Pridat nové snimky do prezentécie.
* Oznacit snimku ako skrytl tak, aby sa nezobrazovala ako sucast prezentécie.
* Qdstranit snimku z prezentacie, ak uz nie je potrebna.
* Premenovat snimku.
* Duplikovat snimku (kopirovat' a vlozit) alebo presundt’ snimku na int poziciu v prezentacii
(vystrihnat a vioZzit).
Je tieZ mozné vykonat aj nasledujlce operécie, aj ked existuju efektivnejSie spbsoby, ako je
pouzitie panelu Snimky:
* Zmenit typ prechodu medzi snimkami pri opustani vybranej snimky alebo za kazdou
snimkou skupiny snimok.

* Zmenit poradie snimok v prezentacii.
* Zmenit vzhlad snimky.
* Zmenit navrh snimky naraz pre skupinu snimok.

Postranny panel

Postranny panel méa sedem Casti — podpanelov. Pozadovany podpanel zobrazime kliknutim na
jeho ikonu alebo kliknutim na znacku s trojuholnikom nad ikonami a zvolenim z kontextovej
ponuky. Zobrazeny méze byt len jeden podpanel.

.

-'=+

Vlastnosti
Zobrazuje rozlozZenia, ktoré su sucastou programu. MdZeme zvolit poZzadované rozloZenie,
pricom ho méZeme pouZit' v jeho pévodnej forme alebo ho méZeme upravit podfa vliastnych
poziadaviek. Vlastné rozloZenia v su¢asnosti nie je mozné ukladat'.

Predlohy snimok !
Tu mdzeme definovat’ Styl snimky (strany) prezentécie. Sucastou Impress je viacero predioh
snimok. Jedna z nich — Predvolena — je prazdna a nema definované Ziadne pozadie.

V hlavnej ponuke zvolenim Format > Styly a formatovanie alebo stlatenim
Tip klavesu F11 otvorime okno Styly a formatovanie, kde méZzeme podla svojich potrieb
modifikovat Styly pouzité v fTubovolnej predlohe. Toto je mozné urobit’ kedykolvek.

Vlastna animécia
V tejto Casti sa hachadza zoznam animacii, ktoré sliZia na zvyraznenie alebo zlepSenie
ro6znych prvkov na snimke. Této €ast poskytuje jednoduchy spbésob na pridavanie, zmenu a
odstranovanie animacii.

Hlavné okno programu Impress
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Prechod medzi snimkami
Obsahuje vela volieb tykajucich sa prechodov. Standardne je nastavena volba Bez prechodu,
pri ktorej sa jedna snimka jednoducho nahradi dalSou. K dispozicii je v8ak vela dalSich
prechodov. M6Zeme tiez zvolit' rychlost prechodu (pomaly, stredne rychlo a rychlo), vybrat
medzi automatickym a ru¢nym prechodom a nastavit' ako dlho ma byt vybrana snimka
zobrazend (len pri automatickom prechode).

Styly a formatovanie [
Tu méZeme upravit' a pouzit Styly grafiky a (len) upravit Styly prezentacie. Ak $tyl upravime,
zmeny sa automaticky pouziju pre vSetky prvky prezentécie, v ktorych je pouzity. Ak chceme,
aby sa Styly na vybranych snimkach neaktualizovali, musime pre ne vytvorit novu predlohu
snimok.

L

Galéria £

Otvori galériu programu Impress, z ktorej mdZzeme do prezentacie prebrat objekt, a to vo forme
kopie alebo odkazu. Kopia objektu je nezavisla od originalu, a preto zmeny originalu képiu
neovplyvnia. Odkaz je zavisly od originalu, a preto zmeny originalu sa prejavia aj v odkaze.

Navigator
Otvori navigator programu Impress, pomocou ktorého mézeme rychlo prechadzat zo snimky
na snimku alebo z objektu na objekt. Odporica sa davat snimkam a objektom zmyslupiné
nazvy, aby sme ich v navigatore mohli lahko identifikovat.

Pracovny priestor

Pracovny priestor (zvyCajne v strede) ma pat kariet: Normalne, Osnova, Poznamky, Podklady a
Zorad'ova€ snimok (obrazok 2). Zalozky tychto piatich kariet nazyvame aj tlacidla nahladov.
Pracovny priestor pod tlacidlami ndhladov sa meni podla zvoleného nahladu. Nahlady pracovného
priestoru st podrobnejSie opisané v €asti ,Nahlady pracovného priestoru” na strane 10.

Mormélne Osnova |Poznamky [Podklady |Zorad'ovad snimok

Obrazok 2: ZaloZky kariet pracovného priestoru

Panely nastrojov

Pri praci na snimke mdZzeme pouZit' nastroje z réznych panelov. Panely mézu byt zobrazené alebo
skryté zvolenim Zobrazit' > Panely nastrojov v hlavnej ponuke alebo pomocou kontextovej
ponuky panelu.

Mbézeme tiez zvolit ikony, ktoré sa maju na jednotlivych paneloch zobrazovat. Viac informacii sa
nachadza v kapitole 1, Predstavujeme LibreOffice.

Mnohé panely nastrojov su v programe Impress podobné ako v programe Draw. Podrobnosti
o dostupnych funkciach a ich pouziti sa hachadzaju v knihe Navod na pouZivanie programu Draw
(Draw Guide).

Stavovy riadok

Stavovy riadok (obrazok 3) sa nachadza v spodnej €asti okna programu Impress. Obsahuje
informécie, ktoré mézu byt uzitoné pri praci s prezentaciou. Podrobnosti 0 obsahu a pouZiti jeho

Hlavné okno programu Impress 9



poli sa nachadzaju v kapitole 1, Predstavujeme LibreOffice a v kapitole 1, Uvod do programu
Impress v knihe Navod na pouZivanie programu Impress (Impress Guide).

Informaéné NeuloZené Styl strany Zvacsenie
pole Zmeny (snimky) v percentach
Editor textu: Odsek 1, Riadok 1, Stpec 1 | =3 1,40 /4,91 & 2520 x 12,18 Snimka 1/ 1| Predvolengé | — . + | 66%
Pozicia Rozmer Elektronicky Cislo Posuvaé
kurzoru prvku podpis snimky zvacsenia (lupy)

Obréazok 3: Stavovy riadok

Rozmery su dané v aktualnych mernych jednotkach (pozor na zamenu s jednotkami
Poznamka pravitka). Tieto jednotky su definované v poloZke Nastroje > MoZnosti >
LibreOffice Draw > VSeobecné hlavnej ponuky.

Zlava doprava na stavovom riadku mdéZzeme najst:
* Informaéna oblast’ - meni sa v zavislosti na vybere. Napriklad:

Priklad vyberu Priklady zobrazenej informéacie

Textova oblast Editor textu: Odsek x, Riadok y, Stipec z

Grafy, tabulkové harky Vybrané: vioZzeny objekt (OLE)

Grafika Vybrané: Rastrovy obrazok s priehfadnostou

* Pozicia kurzora - pozicia kurzora alebo lfavého horného rohu vyberu merana od lavého
horného rohu snimky, za ktorou nasleduje Sirka a vySka vyberu alebo textového okna,
v ktorom sa nachadza kurzor.

* NeuloZené zmeny - priznak indikujuci, Zze subor je potrebné ulozit. Dvojkliknutim na toto
pole otvorime dialégové okno UloZit'.

* Digitalny podpis - priznak indikujuci, €i je dokument digitalne podpisany. Po uloZeni
dokumentu dvojkliknutim na tento priznak otvorime dialdgové okno Elektronické podpisy.

» Cislo snimky - &islo snimky aktualne zobrazenej v pracovnom priestore a celkovy pocet
shimok v prezentacii.

 Styl strany (snimky) - $tyl priradeny snimke, prediohe alebo poznamkam, ktoré st prave

zobrazené v pracovnom priestore. Dvojkliknutim na nazov Stylu otvorime dialégové okno
Vzhlad snimky.

* Posuvac¢ na zmenu mierky — upravuje mierku zobrazenia pracovného priestoru
v percentach.

* Lupa - indikuje mierku zobrazenia pracovného priestoru v percentach. Dvojkliknutim na
percentualnu hodnotu otvorime dialégové okno RezZim lupy a rozloZenie zobrazenia

* Stavovy riadok mozno skryt tak, Ze v hlavnej ponuke zvolime Zobrazit', a tam zruSime
zaskrtnutie pri polozke Stavovy riadok.

Nahlady pracovného priestoru

Kazdy z nahladov pracovného priestoru bol navrhnuty na ulah&enie istej tlohy, je preto vyhodné
sa s nimi blizSie zoznamit.

Nahlady pracovného priestoru
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Kazdy nahlad pracovného priestoru zobrazuje inG sadu panelov s nastrojmi. Tuto
Poznamka sadu moZno upravit' v hlavnej ponuke zvolenim Zobrazit’ > Panely nastrojov, kde
jednotlivé panely zaSkrtneme, alebo ich zaSkrtnutie zruSime.

Nahl'ad Normalne

Nahlad Normalne je hlavny nahlad, ktory je ur€eny na pracu s jednotlivymi snimkami. Pouziva sa
na formatovanie a Upravu vzhladu, pridavanie textu, grafiky a animacii.

Ak chceme snimku umiestnit' do pracovného priestoru (nahfad Normalne) (obrazok 1 na strane 7),
klikneme na jeho miniatiru na paneli Snimky alebo dvojklikneme na jeho nazov v okne Navigator
(viac informécii ndjdeme v kapitole 1, Predstavujeme LibreOffice a v priruCke Navod na pouZivanie
programu Impress (Impress Guide).

Nahl'ad Osnova

Nahlad Osnova (obrdzok 4) obsahuje vSetky snimky prezentacie v ich €islovanom poradi.
Zobrazuje nadpisy, odrazky a €islované zoznamy pre kazdy snimok v podobe osnovy. Zobrazené
su iba texty z predvolenych textovych poli. Ak snimky obsahuju dalSie textové polia alebo grafické
objekty, text z tychto objektov sa nezobrazi. Rovnako sa nezobrazuju ndzvy snimok.

Mormalne | Osnova Poznamky |Podklady | Zorad'ovad snimok
.= Sablona prezentacie
v Vyvojarsky tim LibreOffice
v Verzia 14. 09. 2014 (Vydanie)

@ Priklad predvoleného snimku
“ Tu je miesto pre vas obsah ...
" Obrazok 4: Nahiad Osnova

Formatovanie textu v

FRi=(- 2 R[S ANE A

Obréazok 5: Urovne osnovy a Sipky na pohyb poskytované v paneli nastrojov Formatovanie textu

Liberation Sans w8 | B [ U m

Nahlad Osnova sa pouZiva na Ucely:

1) Zmeny v texte snimok:
* Pridanie a odstranenie textu na snimke.

* Presun odsekov textu vo vybranej snimke smerom hore a dole pomocou Sipok
(Presunat nahor alebo Presunut dole) na paneli nastrojov Formatovanie textu
(zvyraznené v obrazku 5).

* Zmenu Urovne v oshove pre lubovolny odsek v snimke pomocou Sipok dolava a
doprava (O uroven vy3Sie alebo O droven niZsie) na paneli nastrojov Forméatovanie
textu (zvyraznené v obrazku 5).

* Presun odsekov ako aj zmenu ich arovne v osnove pomocou kombin&cie tychto Styroch
Sipok.

Nahlady pracovného priestoru 11



2) Pridanie dalSej snimky. Ak zistime, Ze potrebujeme dalSiu snimku, mézeme ju vytvorit
priamo v nahlade Osnova. M6Zeme sa vSak aj vratit do ndhladu Normalne a vytvorit ju
tam.

Néahlad Poznamky

Nahlad Poznamky (obrazok 6) sa pouziva na pridavanie poznamok k snimkam. Tieto poznamky
sa pocas prezentacie nezobrazuju.

Mormalne |[(Osnova [Poznamky Podklady |Zorad'ovad snimaok

+X 123 4:5:6:7 391411121314151&1?1319205'*

g

Priklad predvolengho snimku

4

 Tu je miesto pre va&s obsah ...

5

- " hiekolloo tipon: 1

o " Powdite prediohy snimok akeo z 2kad pre Sandarné snimiky: ;

i . 1 Je ktied vhodné pridal ndzowv prezenticie do péty snimiku. :

? Viozte ho cez Viozi — Cislo sirany ... — Paa I
2 1 Poudihaie frebnd ={0ffce doddvani spolu s

LibreOffice (libreoffce soc)

1009

Licire ¥ ol pegrama Ui

1411530112011

Kliknat' na vloZenie poznamok v
Obréazok 6: Nahlad Poznamky

1) Klikneme na zalozku Poznamky v pracovnhom priestore.
2) Zvolime snimku, ku ktorej chceme poznamky pridat.
3) Klikneme na panel Snimky alebo dvojklikneme na nazov snimky v okne Navigétor.

4) V textovom poli pod snimkou klikneme na slova Kliknat pre vioZenie poznamok a zadame
poznamky.

5

Velkost textového pola pre poznamky mdzeme zmenit pomocou zvyraznenych manipulatorov,
ktoré sa zobrazia po kliknuti na oramovanie pola. Pole je tiez mozné presunut tak, ze kurzor mysSi
umiestnime na jeho okraj (kurzor sa zmeni na kriz so Sipkami), stlaenim lavého tlacidla mySi ho

3 M7

uchopime a presunieme. Ked chceme zmenit Styl textu, stlacenim klavesu F11 otvorime okno

Styly a formatovanie alebo klikneme na ikonu Styly a formatovanie E v postrannom paneli.

Nahlad Podklady

Nahlad Podklady slGzi na nastavenie rozloZenia snimok pre tlaent podobu prezentacie vo forme
podkladov. V pracovnom priestore klikneme na zalozku Podklady, ¢im sa otvori Cast RozloZenia
v postrannom paneli (obrazok 7), kde mézeme vybrat tlacenie 1, 2, 3, 4, 6, alebo 9 snimok na

=
stranu. Ak sa &ast RozloZenia neotvori, klikneme na ikonu Vlastnosti " na pravej strane
postranného panelu.

Tento nahlad tiez mézeme vyuzit na uréenie, ktoré informacie sa maju v tlacenych podkladoch
zobrazit. Viac informécii o tlaceni snimok, podkladov a pozndmok sa nachadza v kapitole 10,

Nahlady pracovného priestoru 12



TlacCenie, exportovanie, e-mailovanie a ukladanie prezentacii v knihe Navod na pouZivanie

programu Impress (Impress Guide).

Vlastnosti
=l Rozlozenia

Jn

lﬂ.

Obrézok 7: RozloZenia podkladov

Snimky |Poznamky a podidady |

X

Zahrmit’ do strany
Hiavidka:

Text hlavidy: | |

Datum a £as

) Nemenny | |

) Premenny

Format [04/24/14

Jazyk  [angliétina (USA)

Pata

Text paty: | |

[] &islo strany

[ Pouiit’ pre vietky l I

Frusit’

l I Pomocnik

Obréazok 8: Dialégové okno HlaviCka a péta — karta Poznamky a podklady
Z hlavnej ponuky zvolime VloZit' > Cislo snimky alebo Vlozit > Datum a €as, ¢im sa otvori okno

Hlavicka a pata. Klikneme na zalozku Poznamky a podklady (obrazok 8), na zobrazenej karte
zvolime polozky, ktoré sa maju na stranach s podkladmi zobrazit' a zadame ich hodnoty. Viac
podrobnosti 0 pouZivani tohto dial6gového okna sa nachadza v knihe Navod na pouZivanie

programu Impress (Impress Guide).
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Nahlad Zoradova¢ snimok

Nahlad Zoradovac snimok (obrazok 9) obsahuje miniatary vSetkych snimok. Tento nahlad sa
mdze pouzit na pracu s jednou snimkou alebo so skupinou snimok.

IDERS

Mormalne |Osnova | Poznamky F‘udldady|20rad'waﬁ snimok; |

i 2 mm ——
- K ad predy oeneno Snmkd
% 3

ol F=
I LibreQffice Y .

‘ - 1 Mskadkaz 1pov.
k T Poulm vz ve weeey ke vilded pre Gendertl afmicy
1.‘hl:ldl2'.':t|i:'ﬂ; -b:.'mﬁgltm'rm.
Wiots o oz ViEd - Sk Bray e 1
e o e A 1 Pouifvgim fzreiomd meieiu e Tice dodivend v a
- LiEwC T (e o )
Wi ey B LB e
w Wz 18, D0 2018 (Wysderia)

Obrazok 9: Nahlad Zoradovac¢ snimok

Prispésobenie nahladu Zorad'ova¢ snimok
Ked chceme zmenit poCet snimok zobrazenych v jednom riadku:

1) V hlavnej ponuke zvolime Zobrazit' > Panely nastrojov > Zorad'ova€ snimok a
Zobrazenie snimok (obrazok 10)

2) Upravime pocet snimok (maximum je 15).

DERE

Obrazok 10: Panely nastrojov Zoradovac snimok a
Zobrazenie snimok

Prestvanie snimok v zorad'ovaci snimok

Ked chceme v zoradovaci snimku presunut:
1) Klikneme na snimku, ¢im ju vyberieme (obrazok 9).
2) Presunieme ju mySou na nové miesto.

Vyber a presuvanie skupiny snimok
Ked' chceme vybrat' skupinu snimok, pouzijeme jednu z nasledujucich metdod:

* Pomocou klavesu Ctrl — klikneme na prvu snimku a so su¢asnym drzanim klavesu Ctr/
klikanim postupne vyberieme pozadované snimky.

* Pomocou klavesu Shift — klikneme na prvi snimku a so sucasnym drzanim klavesu Shift

klikneme na posledni snimku skupiny. Tymto sa vyberu vSetky snimky medzi prvou a
poslednou.

* Pomocou mysi — klikneme vedla (nalavo alebo napravo) prvej snimky, ktord chceme
vybrat. Pridrzime lavé tlacidlo mySi a kurzor mySi tahame, pokial nie su zvyraznené vSetky
shimky, ktoré chceme vybrat.

Nahlady pracovného priestoru 14



Ked chceme presunut skupinu snimok:
1) Vyberieme skupinu snimok.
2) Pridrzanim lavého tlaCidla mySi uchopime jednu z vybranych snimok a tahanim celu

skupinu snimok presunieme na nové miesto, kde tla¢idlo mysi uvolnime.

Praca v nahl'ade Zoradova¢ snimok

V nahlade Zoradovac snimok moZno so snimkami pracovat rovnako ako v paneli Snimky. Ked
chceme vykonat zmeny, na snimku klikneme pravym tlacidlom mySi a zvolime niektorud
Z nasledujdcich poloZiek kontextovej ponuky:

Nova snimka — prida nova snimku za vybrant snimku (pozri ,Nova snimka“ na strane 19).
Duplikovat’ snimku — vytvori képiu vybranej snimky a vloZi ju hned za fiu (pozri
~Duplikovat snimku“ na strane 19).

Odstranit’ snimku — odstrani vybran( snimku.

Premenovat’ snimku — umozZnuje premenovanie vybranej snimky.

RozloZenie snimky — umozZfuje zmenu rozlozenia vybranej snimky.

Prechod snimok — umoznuje zmenit prechod vybranej snimky.

- Ked chceme upravit jednu snimku, vyberieme ju, a potom pridame poZadovany
prechod.

- Ked chceme upravit skupinu snimok, vyberieme ich a priddme pozadovany prechod.
Skryt snimku — skryté snimky sa nebudd pocCas prezentéacie zobrazovat.

Vystrihnat' — odstrani vybrand snimku a vloZzi ju do schranky.

Kopirovat’' — skopiruje vybrana snimku do schranky bez odstranenia.

Vlozit' — vlozi snimku zo schranky za vybran snimku.

Vytvorenie novej prezentacie

Tato Cast popisuje, ako mozno prezentaciu vytvorit pomocou Sprievodcu prezentaciou.

Tip Prvy krok, ktory musime urobit, je rozhodn(t sa, aky uc¢el méa prezentacia mat a

podla toho si ju naplanovat. Aj ked zmeny mézeme robit kedykolvek, ak mame
predstavu o tom, komu je prezentacia urcena, aka bude jej Struktdra, obsah a akym
spbsobom bude prezentovand, mbze nam to usetrit' vela ¢asu.

Sprievodcu prezentacie spustime pomocou Subor > Sprievodcovia > Sprievodca prezentaciou
v hlavnej ponuke lubovolného komponentu LibreOffice (obrazok 11).

1) V Casti Typ mdZzeme zvolit jednu z nasledujdcich moznosti. Ich detaily su podrobne

rozobrané v knihe Navod na pouZivanie programu Impress (Impress Guide).
- Prazdna prezentacia vytvori prazdnu prezentaciu.

- Otvorit' zo Sablény umozni vytvorenie novej prezentacie na zaklade uz existujlcej
Sablény. V tomto pripade sa sprievodca zmeni a zobrazi zoznam dostupnych Sablén.
Ak Ziadne Sablony doposial vytvorené neboli, zobrazi sa zoznam Pozadia
prezentacie. V zozname vyberieme pozadovanu Sablénu.

- Otvorit existujucu prezentaciu umoziuje pokracovat v praci na uz vytvorenej
prezentacii. Sprievodca sa zmeni a zobrazi zoznam existujucich prezentécii. Zvolime
pozadovanu prezentéaciu.
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Otvorit' zo Sablény, v poli Nahlad sa zobrazi ukazka snimky.

Sprievodca prezentaciou

Typ
(¥ Prézdna prezentadia

) Otvorit' zo Zabldny
() Otvorit’ existujlicu prezentédu

Nihlad

[ Pomocnik ] [ Frusit’ ] <= Spat’ L 55@_'1";53 J [ Wytworit’

Obrazok 11: Viyber typu prezentacie

Sprievodca prezentaciou

Vybrat predlohu snimky
|F‘uzadia prezentace w |

Abstrakina cervena

<Pdvodna:= Y
Abstraking zelend -

Abstrakina Ata v
Vybrat" vystupné medium
Pévodné (%) Obrazovka
Edili Snimuok;
() Félia I “_lm N2hlad
) Papier O Sirokouhly
[ Pomocnik ] [ Frusit” ] [ « < Spat’ ] L ﬁaIEJ}-}- J [ Wytworit’ ]

Obréazok 12: Vyber vzhladu snimky

3) Zvolime vzhlad v Casti Vybrat’ vzhl'ad snimky. V tejto Casti m6Zeme volit v zoznamoch

Pozadia prezentacie a Prezentéacie. Kazda z volieb obsahuje zoznam ponukanych
vzhladov snimok. Ak chceme pouzit iny navrh ako ten, ktory je oznafeny slovom
<Pdvodna>, klikneme na jeho nazov.

- Typy pozadi prezentécie su zobrazené na obrazku 12. Pokial sme vybrali pozadie

prezentacie, zobrazi sa v okne Nahlad.

2) Klikneme na tlagidlo Dalej. Obrazok 12 zobrazuje Sprievodcu prezentaciou v druhom kroku
pri zvoleni mozZnosti Prdzdna prezentéacia v prvom kroku. Ak sme v prvom kroku zvolili

Viytvorenie novej prezentacie
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- <Pbdvodnéd> znamena prezentéaciu bez grafického dizajnu.

4) V Casti Vybrat’ vystupné médium zvolime, ako bude prezentécia pouZzita. Prezentacie sa
obvykle vytvaraju na zobrazovanie na obrazovke pocitaca. Ak je to aj nas pripad, zvolime
Obrazovka. Format snimok vS8ak méZeme kedykolvek zmenit.

Forméat Obrazovka je optimalizovany pre obrazovky s pomerom stran 4:3 (28cm x
21cm), takZe nie je vhodny pre moderné Sirokouhlé obrazovky. Velkost snimok
mézeme kedykolvek zmenit v ndhlade Normalne zvolenim Format > Strana

v hlavnej ponuke.

5) Klikneme na Dalej, ¢im sa zobrazi treti krok Sprievodcu prezentaciou (obrazok 13).
- Zvolime pozZzadovany prechod snimok z roletovej ponuky Efekt.

- Zvolime pozadovanu rychlost’ prechodu medzi jednotlivymi snimkami prezentécie
v roletovej ponuke Rychlost'. Stredne je na zaCiatok vyhovujuca volba.

Sprievodca prezentaciou

Vybrat’ prechod snimok

Efekt Bez efektov v |
Richlost Stredne v |

Vybrat typ prezentade (prechodu snimaok)
(%) Predvoleng

() Automaticky
Dizka pohladu na strar 00:00: 10

Difka pauzy 00:00: 10 Nahlad

Zobrazit' logo

:;u';t'uurit'?

[ Pomocnik ] [ Zrusit’ ] [ =< Spat’ ] Dalej =>

Obréazok 13: Viyber efektu pri prechode snimok

Viytvorenie novej prezentacie



Sprievodca prezentaciou (Abstraktna zelena)

Uved'te zakladné myslienky
Aké je vase meno alebo meno vasej firmy?

Sladky Domaovw

Aky je obsah vaiej prezentade?

\ytvorenie prezentacie

Daldie prezentované myzlienky?

Ako vytvorit’ profesiondlnu prezentaciu

[*

<

[ Pomocnik ] [ Frusit” ] [ « < Spat’ ] [ ﬁaIEJ}-}- ] [ Wytworit’

Obréazok 14: zadavanie informacii o prezentacii

Pokial sme v prvom kroku Sprievodcu prezentéciou nevybrali Sablénu, kroky 4 a 5
sa nezobrazia. Ak klikneme na Vytvorit', nova prezentacia sa vytvori.

6) Klikneme na Dalej, ¢im sa zobrazi Stvrty krok Sprievodcu prezentaciou, v ktorom méZzeme
zadat informaciu o autorovi a o samotnej prezentécii, ktoru vytvarame.

7) Klikneme na Dalej. Zobrazi sa piaty krok Sprievodcu, ktory zobrazuje, ako bude
prezentacia vyzerat (obrdzok 15). Ak sa nahlad prezentacie nezobrazi, zaSkrtneme pole
Nahlad.

8) Ak chceme vytvorit sihrn prezentacie, zaskrtneme Vytvorit' suhrn.

9) Ak klikneme na Vytvorit', nova prezentacia sa vytvori.

Pokial nemame dostatocné sklsenosti, je vhodné prijat’ predvolené hodnoty oboch
roletovych ponuk Efekt aj Rychlost. Obe tieto hodnoty mézu byt zmenené neskor

Tip pocas prace s prechodmi snimok a animaciami. Tieto dve funkcie su podrobnejsie
vysvetlené v kapitole 9, Prezentacie v knihe Navod na pouZivanie programu
Impress (Impress Guide).
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Sprievodca prezentaciou (Abstraktna zelena)

Zvolte vase strany
MNahlad
[ Wytvorit' sdhrn
[ Pomocrik ] [ Zrugit’ ] [ « < Spat’ ] Dalej == ’u';tw.rurlt‘

Obrazok 15: Nahlad prezentacie

Formatovanie prezentacie

Nova prezentacia obsahuje iba jednu prazdnu snimku. V tejto Casti zacneme pridavanim novych
snimok a pripravime ich na vloZenie obsahu.

Vkladanie snimok

Nova snimka
Novu snimku méZeme vloZit' nasledujacimi spdsobmi:
1) V hlavnej ponuke zvolime Vlozit' > Snimka.

2) V paneli Snimky alebo v ndhlade Zoradovac¢ snimok klikneme na snimku pravym tlacidlom
mySi a v kontextovej ponuke zvolime Nova snimka.

3) Pripadne pravym tlacidlom mysi klikneme na prazdny priestor v Pracovnom priestore a
z kontextovej ponuky zvolime Snimka > Nova snimka.

+
4) Mbzeme tiez kliknat na ikonu Snimka v paneli nastrojov Prezentacia. Ak nie je
viditelny, v hlavnej ponuke zvolime Zobrazit’ > Panely nastrojov > Prezentécia.

5) Nova snimka sa prida za vybrana snimku.

Duplikovat’ snimku
Niekedy je vhodné namiesto vytvorenia novej snimky vytvorit kopiu uz existujlicej snimky. Snimku
mo6Zeme duplikovat nasledujdcim postupom:

1) V paneli Snimky vyberieme snimku, ktori chceme duplikovat.

2) V hlavnej ponuke zvolime VloZit' > Duplikovat’ snimku.

3) Alebo, v paneli Snimky alebo v nahlade Zoradovac snimok klikneme na snimku pravym
tlaCidlom mysi a v kontextovej ponuke zvolime Duplikovat’ snimku.
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4) Alebo, pravym tlaidlom mySi klikneme na prazdny priestor v Pracovnom priestore a
z kontextovej ponuky zvolime Snimka > Duplikovat’ snimku.

qE
5) Alebo klikneme na maly trojuholnik vpravo od ikony Snimka =2/ v paneli nastrojov
Prezentacia a v kontextovej ponuke zvolime Duplikovat’ snimku. Ak nie je viditelny,
v hlavnej ponuke zvolime Zobrazit’ > Panely nastrojov > Prezentacia.

6) Nova snimka sa v prezentacii prida za vybrana snimku.

Vyber rozloZzenia snimky

Ked vytvarame prezentaciu, prva snimka zvycajne obsahuje nazov prezentacie. Na to mézeme
pouzit rozloZenie Prazdna snimka alebo jedno z rozloZeni s nadpisom.

o=
Klikneme na ikonu Vlastnosti “*"" na vonkajsej strane postranného panelu, &im zobrazime oblast

RozloZenia s dostupnymi rozloZeniami (obrazok 16). Dostupné su rézne rozlozenia, od prazdnej
snimky az po snimku s polom pre nadpis a Siestimi polami pre obsah.

Vlastnosti x =
H Rozlozenia =
T
]
—_— m
_ =
+‘__j

Obrazok 16: Dostupné rozloZenia snimok

Ked chceme zadat nadzov prezentacie / nadpis snimky, za predpokladu, Ze sme pouZili jedno z
rozlozeni s nadpisom, klikneme do pola s textom Kliknat pre vioZenie nadpisu, a potom zadame
text nadpisu. Ak chceme pridat’ text obsahu, v zavislosti na zvolenom rozlozeni klikneme na
Kliknut pre vioZenie textu. Formatovanie nazvu, podnazvu a textu snimok upravime v Style
prezentacie. Viac informacii najdeme v kapitole 2, PouZivanie predlbh snimok, Stylov a Sablon

v knihe Navod na pouZivanie programu Impress (Impress Guide).

Vzhlad textu a grafickych prvkov mézeme upravit kedykolvek pocas pripravy
. prezentécie. Uprava rozloZenia snimok, ktoré uz maji nejaky obsah, mdze tento
Poznamka e - o Iy S A
obsah ovplyvnit. Preto sa odporuca, aby sme na zaciatku venovali Uprave rozloZenia
snimok dostato¢nu pozornost, ¢im predideme neskorSiemu naruseniu obsahu.
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Nazvy jednotlivych rozloZeni sa zobrazia, pokial je povolené zobrazovanie tipov: ak
kurzor umiestnime nad ikonu v oblasti rozlozeni (rovnako ako aj v pripade inych
ikon), jej ndzov sa zobrazi v malom obdizniku.

Tip Pokial tipy nie st povolenég, v hlavnej ponuke zvolime Nastroje > MoZnosti >
LibreOffice > VSeobecné a zaSkrtneme moznost Tipy. Pokial je zaSkrtnuta aj
moznost Rozsirené tipy, vo vSeobecnosti v tipoch ziskame podrobnejsi popis,
nazvy sa vSak nezobrazia.

Ak chceme rozloZenie snimky zmenit, vyberieme ju v paneli Snimky, aby sa zobrazila

Vv pracovnom priestore, a poZadované rozlozenie zvolime v Casti RozloZenia v postrannom paneli.
Viaceré rozloZenia obsahuju jedno alebo viaceré polia s obsahom. Kazdé z nich mozno
konfigurovat' tak, aby obsahovalo text, video, graf alebo tabulku.

Typ obsahu zvolime kliknutim na zodpovedajicu ikonu, ktora sa zobrazi v strede pola (obrazok
17). Ak do pola chceme vlozit text, klikneme na Kliknut pre vioZenie textu.

Kliknut na vloZenie nadpisu

+ Kliknut na vlozenie textu

VioZit tabulku VioZit graf

B

VieZit obrazok VioZit animaciu (video)

Obrézok 17: Vyber typu obsahu

Uprava prvkov snimky

Snimka obsahuje prvky, ktoré su prevzaté z predlohy snimok, ako aj prvky, ktoré su sucastou
rozloZenia. Je malo pravdepodobné, Ze preddefinované rozloZenia budd nasSim poziadavkam
celkom vyhovovat. Niektoré prvky méZzeme odstranit’ a iné, ako napriklad text a grafiku, méZzeme
vlozit.

V programe Impress nembzeme vytvarat nové rozloZzenia, mdZzeme vSak upravovat velkost a
polohu prvkov rozloZenia. M6zeme tiez pridavat nové prvky bez toho, aby nds obmedzovali poloha
a umiestnenie jednotlivych poli rozloZenia.

Velkost' a polohu pola s obsahom upravime tak, Zze klikneme na jeho vonkajSie ordAmovanie, ¢im sa
zvyrazni a sucasne sa zobrazia manipulatory na zmenu velkosti Pole presunieme tak, ze kurzor
umiestnime nad zvyraznené ordmovanie, ¢im za zmeni jeho tvar. Potom ho mySou uchopime a
presunieme do novej pozicie.
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Ked chceme odstranit nepotrebné prvky:
1) Kliknutim vyberieme poZadovany prvok. Uspesnost vyberu je potvrdena zobrazenim
manipulatorov na zmenu velkosti.

2) Nasledne objekt odstranime stlacenim klavesu Delete.

Zmenu rozloZzenia mozno uskutoCnit' len v nahlfade Zobrazit' > Normalne, o je
predvolend moznost. Zmena predlohy snimok, hoci to je mozné, mé6ze viest

k nepredvidatelnym vysledkom. Tento postup si vyZaduje zvySenu pozornost' a
obvykle aj viaceré pokusy.

Poznamka

Pridavanie textu

Do snimky, ktora obsahuje textové pole, pridame text tak, Ze klikneme na Kliknut pre vioZenie
textu v poli a nasledne text napiSeme. PocCas pisania textu sa automaticky pouziju Styly osnovy.
Uroven kazdého odseku v osnove, ako aj jeho polohu v ramci textu méZzeme zmenit pomocou
tlacidiel so Sipkami v paneli Formatovanie textu (pozri obrazok 5 a ,Nahlad Osnova“ na strane 11).
Viac informacii o praci s textom najdeme v Casti ,Pridavanie a formatovanie textu“ na strane 23.

Pridavanie objektov

Objekty, ako napriklad obrazky, kresby alebo tabulkové harky do snimky vlozime zvolenim polozky
Vlozit' v hlavnej ponuke, kde mbZzeme zvolit pozadovany typ. Viac informacii ndjdeme v Casti
~Pridavanie obrazkov, tabuliek, grafov a médii* na strane 29.

Uprava vzhladu vietkych snimok

Ak chceme zmenit pozadie alebo iné charakteristiky vSetkych snimok, musime zmenit pozadie
aktualnej predlohy snimok alebo vybrat inu predlohu postupom, ktory je opisany v Casti ,Praca s
predlohou snimok a so Stylmi“ na strane 32.

Predloha snimok je snimka so Specifikovanymi charakteristikami, ktora slizi ako Sablona a ako
Startovaci bod na tvorbu ostatnych snimok. Medzi tieto charakteristiky patria pozadie, objekty na
pozadi, formatovanie pouzitého textu a grafika na pozadi.

V programe Impress su k dispozicii viaceré predlohy, ktoré nijdeme v Casti Predlohy snimok

v postrannom paneli. M6zeme vSak vytvorit vlastné predlohy, alebo ich mb6zeme ziskat z inych
zdrojov. Viac informacii o vytvarani a modifikacii predléh najdeme v kapitole 2, PouZivanie predI6h
snimok, Stylov a Sablén v knihe Navod na pouZivanie programu Impress (Impress Guide).

Ak chceme zmenit len pozadie, mdZzeme pouzit nasledujlci postup:

1) V hlavnej ponuke zvolime Format > Strana, a potom zvolime kartu Pozadie v okne
Nastavenie strany, ktoré sa otvorilo.

2) Tu vyberieme jednu z ponukanych moznosti, ktorymi su farba, farebny prechod, Srafovanie
a rastrovy obrazok.

3) Volbu napokon potvrdime kliknutim na OK.

4) Nasledne sa otvori dialogove okno, ktoré nam umozni pouzitie zmeny na vSetky snimky. Ak
klikneme na Ano, Impress automaticky upravi aktualnu predlohu snimok.

Vkladanie a spravne formatovanie pozadia je téma, ktora presahuje ramec tejto
prirucky. Potrebné informacie najdeme v priru¢ke Navod na pouZivanie programu

Poznamka Draw (Draw Guide) v kapitole 4, Zmena atributov objektov alebo v prirucke Navod
na pouZivanie programu Impress (Impress Guide) v kapitole 6, Formatovanie
grafickych objektov.
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Uprava prezentacie

Pokial to nezmenime, pocas prezentacie sa snimky zobrazuju bez efektov prechodu a v tom
poradi, v ktorom s v Zoradovaci snimok. Na prechod na nasledujicu snimku mbéZzeme pouzit
klavesnicu alebo mys.

V hlavnej ponuke v poloZke Prezentacia méZeme okrem iného zmenit' poradie snimok, vybrané

snimky méZeme skryt' a méZeme nastavit automaticky prechod na dalSiu snimku. Na nastavenie
efektu prechodu snimok, animacie snimok a zvukového doprovodu treba pouZit' funkcie, ktoré su
dostupné v postrannom paneli. Podrobnosti najdeme v priru¢ke Navod na pouZivanie programu

Impress (Impress Guide) v kapitole 3, Pridavanie a forméatovanie textu.

Pridavanie a formatovanie textu

Vela snimok prezentacie zrejme bude obsahovat text. V tejto Casti sa zoznamime s postupmi, ako
text pridavat a ako menit' jeho vzhlad. Text sa v snimkach uchovava v textovych poliach. VSetky
podrobnosti o pridavani a formatovani textu najdeme v prirucke Navod na pouZivanie programu
Impress (Impress Guide) v kapitole 3, Pridavanie a formatovanie textu.

Do snimky mézeme pridat dva typy textovych poli:

* Zvolime preddefinované rozloZenie v Casti RozloZenia v postrannom paneli, a to bez
vyberu dalSieho Specidlneho typu obsahu. Tu preddefinované textové polia sa nazyvaju
textové polia automatického rozloZenia.

* Textové pole vytvorime pomocou ikony Text T na paneli Kresba (obrazok 18) alebo na
paneli Text (obrazok 19), alebo pomocou klavesovej skratky F2.

Kresbha v X
K|/ >2EH@TH - %@ -@- ¢ W ¥ %X/ EDRE
Obrézok 18: Panel nastrojov Kresba

Text v ¥

TER-R®

Obréazok 19: Panel nastrojov Text

Pouzitie textovych poli automatického rozlozenia

1) Najskér zvolime zobrazenie snimky Normalne.
2) Klikneme na textové pole Kliknut' pre vlioZenie textu.
3) Pozadovany text napiSeme alebo ho vloZime zo schranky.

PouZivanie textovych poli

1) Najskoér zvolime zobrazenie snimky Normalne.

2) Klikneme na ikonu Text T na paneloch Kresba alebo Text alebo pouZijeme klavesovu
skratku F2. Ak panely Kresba alebo Text nie su viditelné, v hlavnej ponuke zvolime
Zobrazit’ > Panely nastrojov > Kresba alebo Text.

3) Na snimke stlacime lavé tlaCidlo mySi a tahanim vytvorime pole pre text. Na zvislej velkosti
pritom nezalezi, lebo sa pocas pisania prispdsobi podla potreby.

4) Po nastaveni velkosti tlaCidlo mySi uvolnime. V textovom poli, ktoré je v reZime Upravy, sa
nachadza textovy kurzor (farebné ordmovanie zobrazené na obrazku 20).
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5) Pozadovany text napiSeme alebo ho vloZzime zo schranky.
6) Klikneme mimo pola, ¢im sa zrusi jeho vyber.

Velkost textového pola méZzeme zmenit, m6Zeme ho presunut alebo aj zmazat. Podrobnosti
najdeme v prirucke Navod na pouZivanie programu Impress (Impress Guide) v kapitole 3,
Pridavanie a formatovanie textu.

PouiZivanie textovych ramcov

= Kliknite na ikonu TE ¥T na paneli nastrojov K.RE SE Aalebo
TEXT, alebo pouZite klavesowvl skmtku F2. Pokial nie si
panely nastrojov KRE SEAalebo TE XT zobrazené chodte do
menu Zobrazit = Fanely nastrojov a wherte KRESEU a TEXT.

= Kliknutim a tahanim nakreslite v =nimke ram ek pre text.
Meboijte =a o verikdlnu velkost textoveho pola, bude =a
vertikalne rozZimwat podla potreby, ako budete pizat.

= Po dokonéeni uvolnite tlacidlo myEi. Kurzor =a zobraz v
textovom poli, ktoré je teraz v reZime Oprav (farebny okraj je
Znazomeny na obr. 20)

L LibreCfice P

Obrazok20: Viytvorenie a Uprava textového pola

Zvisly text

Okrem beznych textovych poli, v ktorych je text orientovany vodorovne, mézeme vlozit' aj pole
s textom orientovanym zvisle. Zvisly text je vSak dostupny len vtedy, ked su aktivované azijské
jazyky v Nastroje > MoZnosti > Nastavenie jazyka > Jazyky. Pole so zvislym textom vytvorime

tak, Ze klikneme na ikonu Vertikalny text™ v paneli nastrojov Kresba alebo Text.

Rychla zmena vel'kosti pisma

V programe Impress sa na paneli Formatovanie textu nachadzaju ikony Zvaésit’ pismo a Zmensit’
pismo (zvyraznené na obrazku 21), pomocou ktorych mdéZzeme pismo zmenSovat alebo
zvacSovat. Zmena velkosti pisma zavisi na velkostiach, ktoré su pre dané pismo dostupné.

Formatovanie textu ¥ X
SRz HKE| SR AME A

Obrazok 21: Rychla zmena velkosti pisma na paneli Formatovanie textu

lberatonSans | (2 % B J U M

Vkladanie textu

Text m6Zzeme do textového pola zadat aj tak, Ze ho skopirujeme v inom dokumente a do
prezentacie ho vlozime. Formatovanie vkladaného textu sa vSak pravdepodobne nebude zhodovat
s formatovanim okolitého textu alebo textu na ostatnych snimkach v prezentécii. Toto sice niekedy
moZe byt poZzadované, vo vacsSine pripadov vSak chceme mat prezentaciu formatovanu jednotne a
nechceme mat ré6zne formatované odseky alebo rozne typy a velkosti pisem a podobne.
Konzistenciu prezentacie mézeme zabezpecit viacerymi spésobmi.
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Vkladanie neformatovaného textu
BeZnou praxou je vkladanie textu bez formatovania s tym, Ze formatovanie sa spravi neskor. Ak
chceme vlozit' text bez formatovania:
1) Pouzijeme klavesovu skratku Ctrl+Shift+V a v okne Vlozit inak zvolime Neformatovany
text.
2) Druhou moznostou je kliknat' na maly trojuholnik pri ikone Vlozit' na Standardnom paneli
nastrojov a zvolit Neformatovany text v kontextovej ponuke.
3) Na formatovanie takto vloZzeného textu sa pouZzije nastavenie Stylu odseku alebo osnovy na
pozicii kurzora v poli automatického rozloZenia alebo Standardny Styl textu v normalnom
textovom poli.

Formatovanie vioZeného textu

Ak chceme formatovat vioZeny text, pouzijeme nastroje na priame forméatovanie na paneli
Formétovanie textu (obradzok 22) alebo v Castiach Znak a Odsek na postrannom paneli (obrazok
23). Ak sa Cast' Znak alebo Odsek automaticky po vybere textu neotvori, klikneme na ikonu
Vlastnosti na pravej strane postranného panelu.

Formatovanie textu ¥ X
lberationSans |28 ¥ B [ U M gL = = a8 AR A-

Obrazok 22: Panel nastrojov Formatovanie textu
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Obrézok 23: Postranny panel, cast Znak

Ak vkladame text do pola automatického rozlozenia, treba pouzit' zodpovedajlci Styl osnovy,
aby text ziskal rovnaky vzhlad, ako zvySok prezentécie.

1) Text vloZime na poZadované miesto.
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2) Prave vlozeny text vyberieme.
3) V hlavnej ponuke zvolime Format > Predvolené formatovanie.

4) Na presunutie textu na spravnu poziciu a Uroven osnovy pouzijeme Styri Sipky na paneli
Formatovanie textu (zvyraznené na obrazku 5 na strane 11).

Sipka dolava presunie polozku zoznamu na vy3Siu Groveri osnovy (napriklad
Zz Osnova 3 na Osnova 2).

Sipka doprava presunie poloZku zoznamu na nizsiu Groven osnovy.
Sipka hore presunie polozku v zozname nahor.
Sipka dolu presunie polozku v zozname nadol.

5) Pripadné dalSie Upravy pisma, tabulatorov atd. spravime rucne.

Po vlozeni textu do textového pola mdZzeme pouzit Styly na jeho rychle formatovanie. Pouzit
mézeme len jeden graficky Styl, a to nasledujicim spésobom:

1) Text vloZime na poZadované miesto.

2) Préave vloZeny text vyberieme.

3) Zvolime poZadovany graficky Styl na formatovanie textu.

4) Pripadné dalSie upravy pisma, tabulatorov atd. spravime rucne.

Vytvaranie odrazkovych a €islovanych zoznamov.

Postup na vytvaranie Cislovanych a odrazkovych zoznamov je zavisly na type pouzitého textového
pola. Nastroje na ich spravovanie a Upravu vzhladu su vSak rovnaké. V textovych poliach
automatického rozlozenia je predvolenym Stylom odrazkovy zoznam. V beznych textovych poliach
je na vytvorenie odrazkového zoznamu potrebny dodato¢ny krok.

Textové polia automatického rozlozenia

Textové polia v dostupnych rozloZeniach snimok su vopred formatované ako odrazkové zoznamy.
Snimku s odrazkovym zoznamom vytvorime nasledujdcim postupom:

1) V paneli RozloZenia zvolime rozloZenie, ktoré obsahuje textové pole.

2) V textovom poli klikneme na Kliknat' pre vioZenie textu.

3) Vlozime svoj text a stlaCime klaves Enter, ¢im sa vytvori nova polozka v zozname
s odrazkou.

4) Predvoleny typ je odrazkovy zoznam. Postup na zmenu vzhladu zoznamu je vysvetleny
v Gasti ,Zmena vzhladu zoznamu* na strane 27.

Tip

Ak stlacime kombinéaciu klavesov Shift+Enter, vytvori sa nova polozka v zozname
bez odrazky. Novy riadok bude mat rovnaké odsadenie ako predchadzajuci riadok.
Ak chceme vytvaranie odrazok celkom zrusit, klikneme na ikonu Odrazky zaplvyp

5 na paneli Formatovanie textu. Ak tento panel nie je zobrazeny, zaSkrtneme ho
v hlavnej ponuke v Zobrazit’ > Panely nastrojov > Formatovanie textu.

Textové polia
Odrazkovy zoznam v textovom poli vytvorime nasledujicim postupom:

1) Klikneme na ikonu Text T na paneli Kresba a v snimke vytvorime textove pole.

2) Klikneme na ikonu Odrazky zaplvyp a= na paneli Formatovanie textu.
3) Vlozime text a stlaime klaves Enter, ¢im sa vytvori nova polozka s odrazkou.

Pridavanie a formatovanie textu
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4) Predvoleny typ je odraZkovy zoznam. Postup na zmenu vzhladu zoznamu je vysvetleny
v Casti ,Zmena vzhladu zoznamu*® na strane 27.

Vytvorenie novej urovne osnovy
V textovom poli automatického rozlozenia vytvorime novu Uroven osnovy takto:
1) Ak je to potrebné, stlacime Enter aby sa vytvorila nova polozka v zozname.

2) Ak chceme uroven polozky znizit' (posunut doprava), stlaCime klaves Tab, na paneli
Formatovanie textu stlac¢ime ikonu O Uroven niZSie (Sipka vpravo) alebo pouzijeme
kldvesovu skratku Alt+Shift+Sipka vpravo. PoloZka zoznamu sa nasledne posunie doprava
a je odsadend na dalSej Urovni osnovy.

3) Opatovnym stlacenim klavesu Enter vytvorime nova polozku v zozname na rovnakej
arovni.

4) Ak chceme uroven polozky zvySit (posunuat dolava), stlacime kombinaciu klavesov Shift
Tab, na paneli Formatovanie textu stlacime ikonu O Uroven vySSie (Sipka viavo) alebo
pouzijeme klavesovu skratku Alt+Shift+Sipka viavo. Polozka zoznamu sa nasledne posunie
dolava a je odsadena na najblizSej vySSej arovni osnovy.

5) Opatovnym stlaenim klavesu Enter vytvorime nova poloZzku v zozname na rovnakej
arovni.

V textovych poliach automatického rozloZenia zvySenie alebo zniZenie Grovne osnhovy polozky
zoznamu zodpoveda pouZitiu iného Stylu osnovy. Druha Uroven v osnove odpoveda Stylu Osnova
2, tretia Uroven Stylu Osnova 3 atd. Zmena urovne osnovy preto sposobi aj dalSie zmeny, ako
napriklad zmenu velkosti pisma alebo zmenu odrazky.

V textovych poliach zmenime droven polozky v osnove pomocou klavesu Tab na nizSiu a
kombinaciou Shift+Tab na vysSiu.

Urovefi osnovy, na rozdiel od programu Writer, nemozno zmenit vybranim polozky a
Poznamka néslednym kliknutim na poZadovanu Uroven osnovy. Tento postup nie je mozny kvoli
tomu, ako su v programe Impress implementované Styly.

Zmena vzhladu zoznamu

Vzhlad zoznamu mdZeme upravit zmenou typu odrazok alebo €islovania, a to bud pre cely
zoznam, alebo len pre jednu poloZku. VSetky zmeny mozno vykonat v okne Odrazky a Cislovanie
(obrazok 24), ktoré otvorime zvolenim Format > Odrazky a ¢islovanie v hlavnej ponuke alebo

B—
- z - a4 vz - n . 7 -
kliknutim na ikonu Odrazky a €islovanie 815 na paneli Formatovanie textu.
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Odrazky a Cislovanie

Odrazky Cislovanie |Obrézok |Poloha |Prispésobit”
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Obrazok 24: Dialégové okno OdraZky a Cislovanie
Pre cely zoznam:

1) Vyberieme cely zoznam alebo klikneme na oramovanie jeho textového pola tak, aby sa
zobrazili manipulatory na zmenu velkosti.

2) V hlavnej ponuke zvolime Format > Odrazky a ¢islovanie alebo klikneme na ikonu

.~
Odrazky a Cislovanie 855 na paneli Formatovanie textu.

3) Dialégové okno Odrazky a Eislovanie (obrazok 24) méa péat kariet: Odrazky, Cislovanie,
Grafika, Poloha a Prispdsobit.

- Ak chceme upravit zoznam s odrazkami, zvolime pozadovany Styl odraZzok
Z predvolenych Stylov na karte Odrazky.

- Ak chceme graficky Styl odrazok, zvolime kartu Grafika.

- Ak potrebujeme vytvorit o&islovany zoznam, na karte Cislovanie zvolime jeden
z predvolenych Stylov Cislovania.

- Na karte Poloha mb6zeme nastavit odsadenie, odstup Cislovania a zarovnanie
zoznamu.

- Na karte Prispésobit méZeme upravit Cislovanie, farbu, relativnu velkost a znak
zoznamu.

4) Ak chceme upravit jednu polozku zoznamu, klikneme na jej text a potom postupujeme
podfla horeuvedenych krokov 2 a 3.

Pokial bol zoznam vytvoreny v textovom poli automatického rozlozZenia, tak jeho vzhfad mézeme
zmenit' aj Upravou Stylov osnovy. Zmeny v Styloch osnovy sa prejavia vo vSetkych snimkach,
v ktorych sa pouZivaju.

Pridavanie a formatovanie textu
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Pridavanie obrazkov, tabuliek, grafov a médii

V poliach pre obsah mézu byt rovnako ako text umiestnené aj obrazky, tabulky, grafy a média.
V tejto Casti uvadzame struény navod, ako s nimi pracovat. Viac informacii o pridavani obrazkov,
tabuliek, grafov a médii najdeme v prirucke Navod na pouZivanie programu Impress (Impress

Guide).

Pridavanie obrazkov

Ak chceme do pola pridat’ obrdzok:

1)
2)

3)
4)

V hlavnej ponuke zvolime Vlozit' > Obrazok > Zo suboru alebo Skenovanie.

Druha moznost je, Ze po vloZeni novej snimky na nej klikneme na ikonu Vlozit' obrazok
(obrazok 17 na strane 21) a v okne Vlozit obrazok, ktoré sa otvori, zvolime prislusny subor.
Ak chceme v okne VloZit obrazok zobrazit nahlad obrazka, zaSkrtneme pole Nahlad v jeho
dolnej Casti.

Obréazok presunieme na pozadované miesto.
Velkost obrazka sa automaticky prispdsobi velkosti pola.

Ak chceme zmenit velkost grafiky, klikneme na fiu pravym tlacidlom mysi.
V kontextovej ponuke zvolime Umiestnenie a velkost’ a v novootvorenom okne
zaSkrtneme atribat Zachovat’ pomer . Potom podla potreby nastavime vysSku alebo

Poznamka  Sirku. Pri zmene jedného rozmeru sa zmeni aj druhy rozmer tak, aby sa zachoval

pomer velkosti stran. Ak tento atrib(t nezaSkrtneme, obrazok bude deformovany.
Zmenou velkosti rastrového obrazka sa jeho kvalita zhorSuje. Preto sa odporuca
vytvorenie obrazka uz v pozadovanej velkosti mimo programu Impress.

Pridavanie tabuliek

Ked' chceme do snimky pridat tabulku:

1)

2)

3)
4)
5)

6)

V hlavnej ponuke zvolime Vlozit' > Tabul'ka alebo na Standardnom paneli nastrojov

klikneme na ikonu Tabulka =,

Ak sa uz na snimke tabulka nachadza a je aj vybrana, klikneme na ikonu Tabulka == na
paneli Tabulka. Panel Tabulka je zobrazeny len vtedy, ak je v hlavnej ponuke zaSkrtnuta
polozka Zobrazit' > Panely nastrojov > Tabulka a ak je vybrana tabulka.

Druh& moZznost je, Ze po vioZeni novej snimky na nej klikneme na ikonu VloZzit' tabul'ku
(obrdzok 17 na strane 21).

Otvori sa okno VloZit tabulku, v ktorom zvolime poZzadovany pocet riadkov a stipcov.

Ind moznost je, Ze klikneme na maly trojuholnik vpravo od ikony Taburlka £ a podet
riadkov a stlpcov vyberieme tahanim kurzora, pricom drzime stlacené lavé tlaidlo mysi.

Styl zvolime zo zoznamu moZnosti dostupnych pre tabulku v ¢asti Navrh tabulky na
postrannom paneli(obrazok 25). Ak sa Cast’ Navrh tabulky automaticky neotvori, klikneme

i
na ikonu Vlastnosti " na pravej strane postranného panelu.
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Obrazok 25: Postranny panel, ¢ast Navrh tabulky

Volbou lubovolneho Stylu z moZnosti, ktoré su uvedené v sekcii Navrh tabulky
Poznamka Vv postrannom paneli vytvorime tabulku s prislusnymi viastnostami. Styl tabulky vSak
moZno aplikovat’ aj vtedy, ked sme tabulku vytvorili inou metédou.

Panel nastrojov Tabulka v programe Impress ponuka rovnaké funkcie ako panel Tabulka
v programe Writer, okrem funkcii Zoradit' a Sucet. Ak chceme tieto funkcie v prezentacii pouzit,
treba do nej vloZzit harok programu Calc.

Viytvorent tabulku mdZeme dalej upravovat. M6Zeme pridavat a odstrafiovat riadky a stipce,
upravovat Sirku a medzery, pridavat oramovanie, pozadie, farby a podobne. Podrobnosti najdeme
v priru¢ke Navod na pouZivanie programu Impress (Impress Guide) v kapitole 3, Pridavanie a
formatovanie textu a v priruCke Navod na pouZivanie programu Writer (Writer Guide) v kapitole 9,
Praca s tabulkami.

Vkladanie Udajov do buniek tabulky je obdobné ako praca s textovymi poliami. Klikneme na
pozadovanu bunku a zacneme pisat text. Na rychly prechod medzi bunkami tabulky mézeme
pouzit' klavesnicu:

e Stlacenim klaves so Sipkami presunieme kurzor bud do dalSej bunky, ak je bunka prazdna,
alebo na nasledujdci znak, ak obsahuje text.

e Stlacenim klavesu Tab prejdeme do bunky vpravo a stlacenim Shift+Tab do bunky vlavo.
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Pridavanie grafov

Ked chceme do snimky pridat’ graf:
1) V hlavnej ponuke zvolime Vlozit' > Graf alebo na Standardnom paneli nastrojov klikneme

na ikonu Graf I O,

2) Ak sme prave vytvorili novu snimku, méZzeme graf viozit' aj kliknutim na ikonu Vlozit’ graf
(obrazok 17 na strane 21).

3) Impress viloZi predvoleny graf a otvori sa dialogové okno Graf. Detaily o modifikovani typu
grafu, vkladani vlastnych Gdajov a zmene formatovania najdeme v priru¢ke Navod na
pouZivanie programu Impress (Impress Guide).

Pridavanie suborov médii

Ked' chceme do snimky pridat subory s médiami, ako su hudba a filmové klipy:
1) V hlavnej ponuke zvolime VloZit' > Video a zvuk.

2) Ak sme prave vytvorili novi snimku, mdézZzeme kliknat' na ikonu Vlozit' video (obrazok 17 na
strane 21).

3) V dolnej Casti pracovnej plochy sa otvori panel prehravaca médii, pomocou ktorého si ho
mobzeme prehrat.

4) Ak vlozime zvukovy subor, v kontextovom poli sa zobrazi obrazok s reproduktorom.

V operacnom systéme Linux, napriklad v Ubuntu, si treba nainStalovat vhodny
, prehravac médii. Najprv treba stiahnut’ a nainStalovat' Java Media Framework API
Poznamka (JMF), a potom v zozname Cesta k triedam v Nastroje > MoZnosti > LibreOffice >
Java pridat cestu k stboru jmf. jar.

Pridavanie grafiky, tabul'kovych zoSitov a inych objektov

Na obohatenie textu v snimkach sa €asto pouZivaju grafické prvky, ako napriklad r6zne utvary,
bubliny s textom, Sipky a podobne. S tymito objektmi sa v Impress pracuje podobne ako

v programe Draw. Podrobnosti najdeme kapitole 7, ZaCiname s programom Draw v prirucke
Navod na pouZivanie programu Draw (Draw Guide) alebo v kapitolach 4, 5 a 6 v prirucke Navod
na pouZivanie programu Impress (Impress Guide).

Harky vloZzené do snimky poskytuju vac¢sinu funkcii harkov programu Calc, a tak umoznuju
vykonavanie velmi zloZitych vypoctov, ako aj analyzy udajov. Ak potrebujeme analyzovat' Udaje
alebo pouzit' vzorce, najvhodnejSie bude, ak na to pouzijeme harok programu Calc a vysledok len
umiestnime do snimky, a to vloZzenim Calc harku alebo skopirovanim Udajov do tabulky

Vv programe Impress.

Druh& moZznost je pouZzit volbu VloZit' > Objekt > OLE objekt > ZoSit LibreOffice v hlavnej
ponuke. V strede snimky sa otvori tabulkovy harok a ponuky a panely programu Impress sa
zmenia na ponuky a panely programu Calc. Do harku zaneme zadavat Udaje, pricom mozno
bude treba prispdsobit’ velkost viditelnej oblasti harka. Do snimky tiez méZeme vlozZit' existujuci
hérok, pricom jeho zobrazenie nastavime tak, aby poZzadované udaje boli viditelné.

Do snimok programu Impress mdZeme vkladat objekty r6znych typov, ako napriklad textové
dokumenty programu Writer, matematické vzorce programu Math, iné prezentacie a podobne.
Podrobnosti najdeme v priru¢ke Navod na pouZivanie programu Impress (Impress Guide)

v kapitole 7, Vkladanie tabulkovych dokumentov, grafov a inych objektov.
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Praca s predlohou snimok a so Stylmi

Predloha snimok je snimka, ktora slizi ako vychodiskovy bod pre dalSie snimky. V tomto zmysle
hra podobnu Ulohu ako Styl strany v programe Writer, lebo ur€uje zakladné forméatovanie v3etkych
snimok, ktoré na nej zavisia. Jedna prezentacia méze pouzivat viac ako jednu predlohu snimok.

Predloha snimok definuje sadu charakteristik vratane farby pozadia, grafickych prvkov, gradientov
a dalSich objektov (ako napriklad loga, dekorativne €iary a podobne), hlavicky a paty, polohy a
velkosti ramcov a formatu textu.

Styly

VSetky charakteristiky predlohy snimok méZzeme nastavit pomocou Stylov. Nové snimky, ktoré boli
vytvorené z predlohy snimok, obsahuju jej zdedené Styly. Zmena Stylu v predlohe preto spésobi
zodpovedajucu zmenu vo vSetkych snimkach, ktoré z nej boli vytvorené. Jednotlivé snimky vSak
mobzeme upravit bez toho, aby sme ovplyvnili prediohu.

Aj ked sa odporuca, aby sa predlohy snimok pouzivali Co najviac, prilezitostné
Poznamka  manuélne Upravy m6zu byt potrebné, a to napriklad vtedy, ked sa pouzije
rozloZenie s textom a grafom.

S predlohami snimok s spojené dva typy Stylov: Styly prezentacie a Styly objektov. Styly
prezentacie, ktoré su sucastou programu Impress, mézeme menit, nembézeme vSak vytvarat nové
Styly. V pripade Stylov objektov ich m6Zeme nielen modifikovat, ale méZeme vytvarat aj vlastné
Styly.

Styly prezentéacie ovplyviujd tri prvky prediohy snimok: pozadie, objekty pozadia (ikony,
dekorativne Ciary a textové ramce) a text umiestneny v snimke. Styly textu sa dalej delia na
Poznamky, Osnova 1 az Osnova 9, Podnadpis a Nadpis. Styly osnovy sa pouZivaji pre rézne
arovne osnovy, ku ktorym patria. Napriklad Osnova 2 sa pouziva ako podpolozka urovne Osnova
1, Osnova 3 sa pouziva ako podpolozka Urovne Osnova 2 atd.

Styly objektov nie st obmedzené a mdZzu ovplyviiovat vela prvkov snimky. VSimnime si, Ze textové
Styly existuju v Styloch prezentacie, ako aj v Styloch objektov.

Predlohy snimok

Sucastou programu Impress je viacero predléh snimok. Tieto predlohy su zobrazené v podpaneli
Predlohy snimok postranného panelu (obrdzok 26) a su delené na tri skupiny: PouZité v tejto
prezentécii, Nedavno pouZité a Dostupné na pouZitie. Ak klikneme na znak + vedla ndzvu
podcasti, podcast’ s miniatirami snimok sa zobrazi. Ak klikneme na znak —, miniat(ry sa skryju.

Predlohy snimok, ktoré sa nachadzaju v zozname Dostupné na pouZitie, pochadzaju zo Sablény
s rovnakym nazvom. Pokial sme vytvorili svoje vlastné Sablony alebo sme ich pridali z iného
zdroja, tak predlohy snimok, ktoré sa v nich nachadzajd, sa tiez objavia v tomto zozname.
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Obrézok 26: Postranny panel, podpanel Predlohy snimok

Predloha snimok -
= =1 | Zatvorit zobrazenie prediohy

Obrazok 27: Panel nastrojov Predloha snimok

Vytvorenie predlohy shimok

Postup na vytvorenie novej predlohy snimok je podobny ako Uprava predlohy snimok.
1) Do rezimu Gpravy predlohy prejdeme tak, Ze v hlavnej ponuke zvolime Zobrazit' >
Predloha > Predloha snimok, ¢im sa zobrazi panel nastrojov Predloha snimok (obrdzok
27). Ak sa tento panel nezobrazi, zvolime Zobrazit’ > Panely nastrojov > Predloha
snimok.
2) V paneli Predloha snimok potom klikneme na ikonu Nova predloha IEI/'.

3) V paneli Snimky pribudne nova predloha. Tuto predlohu upravime podla svojich predstav.

4) Dalsim odporu¢anym krokom je premenovanie novej predlohy. Na snimku v paneli Snimky
klikneme pravym tla€idlom mysi a v kontextovej ponuke zvolime Premenovat’ prediohu.

5) Po ukonceni Uprav na paneli Predloha snimok klikneme na tlaCidlo Zatvorit' zobrazenie
predlohy, ¢im prejdeme do bezného rezimu Upravy snimok.
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Pouzitie predlohy snimok

Ak chceme niektora predlohu snimok pouzit' pre vSetky snimky v prezentacii:
1) Klikneme na ikonu Predlohy snimok

predlohy snimok (obrazok 26).
2) Ak chceme jednu z predldh pouZit pre vSetky snimky v prezentécii, klikneme na fiu pravym
tlaidlom mysi a v kontextovej ponuke zvolime PouZit’ pre vSetky snimky.
Ak chceme pre jednu alebo viacero snimok pouzit ina predlohu snimok ako pre ostatné:
1) V paneli Snimky zvolime snimku alebo snimky, pre ktoré chceme novu predlohu pouZzit.

2) V postrannom paneli klikneme pravym tlacidlom mysi na poZzadovanu predlohu a
v kontextovej ponuke zvolime Pouzit’ pre vybrané snimky.

postrannom paneli, ¢im otvorime podpanel

Nacitanie dalSich predloh snimok

Niekedy mbzZe nastat situacia, ked' v jednej prezentacii chceme kombinovat' viacero predldh
snimok, ktoré sa vSak nachadzaju v roznych Sablénach. Napriklad, méZeme poZadovat celkom iné
rozloZenie pre prvi snimku alebo chceme pridat’ snimku z inej prezentéacie (ktora je zaloZena na
Sabléne, ktora sa nachadza na pevnom disku).

Predloha snimky

Vybrat’ predlochu snimky

Default

[ ] odstranit’ nepouzité pozadia

| ok ||zt || pomock || nediat.

Obréazok 28: Dialégové okno Navrh snimky

1) V hlavnej ponuke zvolime Format > Navrh snimky, alebo pravym tlacidlom mysi klikneme
na snimku v paneli Snimky a v kontextovej ponuke zvolime Navrh snimky. Otvori sa okno
Navrh snimky (obrazok 28). V tomto okne s zobrazené predlohy, ktoré su k dispozicii na
pouZzitie.

2) Ak chceme pridat’ viac predléh, klikneme na tlaCidlo Nacitat’, ¢im otvorime okno Nacitat’
predlohu snimky (obrazok 29).
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Obréazok 29: Dialégové okno Nacitat’ navrh snimky
3) V tomto okne vyberieme Sablonu, z ktorej chceme nacitat predlohu a klikneme na OK.
4) Opatovne klikneme na OK, ¢im okno Navrh snimky zatvorime.

5) Predlohy, ktoré sme vybrali v Sabléne, su teraz zobrazené v pod€asti Dostupné pre
pouZitie v Casti Predlohy stran.

Nacitané predlohy budd dostupné aj nabuddce, ked prezentaciu otvorime. Ak
chceme nepouzité predlohy odstranit, zaSkrtneme prislusné pole v okne Navrh

Poznamka snimky. Ak predloha v prezentacii nebola pouzita, odstrani sa zo zoznamu
dostupnych predIéh.
Tip Ak chceme zmensit' velkost stboru s prezentaciou, mézeme znizit' pocet pouzitych

predldh.

Uprava predlohy snimok

Na predlohe snimky mozno upravit tieto prvky:

* Pozadie (farba, farebny prechod, Srafovanie a rastrovy obrazok)

* Objekty pozadia (napriklad logo alebo ozdobna grafika)

* Velkost, poloha a obsah prvkov hlavicky a paty, ktoré sa zobrazia na kazdej snimke

* Velkost a poloha predvolenych rdamcov pre nazov snimky a obsah
(viac informécii o Uprave predlohy snimok stran najdeme v kapitole 2, PouZivanie predlbh snimok,
Stylov a Sablén v knihe Navod na pouZivanie programu Impress (Impress Guide).

1) V hlavnej ponuke zvolime Zobrazit' > Predloha > Predloha snimok. Tymto sa odomkn(
vlastnosti predlohy a mézeme ju upravovat.

2) Predlohu snimok zvolime v podpaneli Predlohy snimok v postrannom paneli.

3) V pracovnom priestore v predlohe vyberieme objekt. V postrannom paneli sa nasledne
zobrazia nastavenia, ktoré pre vybrany objekt m6Zeme zmenit. Na obrazku 30 je
zobrazeny vybrany graficky objekt a otvorena Cast obrazok v podpaneli Vlastnosti
postranného panelu.

4) V predlohe spravime potrebné zmeny a nasledne bud klikneme na ikonu Zatvorit’
zobrazenie predlohy na paneli Predloha snimok alebo v hlavnej ponuke zvolime Zobrazit’
> Normalne, ¢im rezim Upravy predlohy opustime.

5) Pred pokracovanim prezentaciu ulozime.
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VSetky zmeny spravené na predlohe v reZime Upravy predlohy sa prejavia na
vSetkych snimkach, ktoré tato predlohu pouzivajd. VZdy si preto pred pokracovanim

Poznamka prace na Uprave snimok overime, Ze sme zatvorili zobrazenie predlohy a presli do
rezimu Normalne zobrazenie.
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Obrézok 30: Uprava predlohy snimok

Zmeny, ktoré sme manuélne spravili na jednotlivych snimkach v reZime Normalne
zobrazenie (napriklad zmena Stylu odrazok, farba nazvu a podobne) nebudi po
Uprave predlohy zmenené. Preto sa mézu vyskytnut situacie, ked chceme manuéalne
zmeny odstranit’ a chceme sa vrétit k predvolenému Stylu. Ak sa chceme vratit

k predvolenému Stylu, vyberieme prislusny prvok a v hlavnej ponuke zvolime
Format > Predvolené formatovanie.

Poznamka

Pridavanie textu, paty a poli k vSetkym snimkam

Do predlohy snimok mézeme pridat text, patu a polia, ktoré sa zobrazia na kazdej snimke
prezentacie. Hlavicka sa obvykle do snimok nepridava.

Text

1) Pomocou Zobrazit’ > Predloha > Predloha snimok v hlavnej ponuke zobrazime nahlad
predlohy snimok(obrazok 31).

2) Na paneli Kresba klikneme na ikonu Text alebo stlacime klaves F2.

3) Klikneme na plochu predlohy a tahanim, pricom drzime stlaCené lavé tlacidlo mysi,
vytvorime rdmec textového objektu, do ktorého napiSeme alebo vloZime poZzadovany text.

4) Po zadani textu, ktory sa ma objavit' na vSetkych snimkach prezentacie, v hlavnej ponuke
zvolime Zobrazit' > Normalne alebo klikneme na Zatvorit’ zobrazenie prediohy.

Péta
Ak chceme do snimok pridat’ patu:

1) Pomocou Zobrazit’ > Predloha > Predloha snimok v hlavnej ponuke zobrazime nahlad
predlohy snimok(obrazok 31).
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2) Z hlavnej ponuky zvolime Vlozit > Cislo snimky alebo VloZit' > Datum a €as, ¢im sa
otvori okno Hlavicka a péata (obrazok 32).

3) V okne v dostupnych mozZnostiach zvolime typ datumu a ¢asu, zadame text paty a Cislo
snimky.

4) Klikneme na PouZit’ pre vSetky, ak chceme, aby sa zmena pouZzila pre vSetky snimky
prezentacie, alebo na Pouzit', ak chceme aby sa pouzila len pre vybrani snimku.

5) Druha moznost je pridat datum, Cas, text paty a ¢islo snimky priamo do prisluSnych poli,
ktoré vidime na obrazku 31.

Kliknut na upravu formatu textu titulku

~ Klikn(t na Gpravu formatu textu osnovy
~ Druha droven

~ Tretia Uroven
~ Stvrta Grovei osnovy
W Piata Groven osnovy
“ Siesta Urovef
W Siedma droven

=datum/tas= =pata= =Cislo=
Obrézok 31: Priklad predlohy snimok

V snimkach sa obvykle pouziva len pata. Ak chceme vytvorit’ hlavicku, pouzijeme

Poznamka textové pole podla postupu v Casti , Text* na strane 36.
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Obréazok 32: Dialégové okno Péta v programe Impress

Polia

Ak do objektu chceme pridat’ pole, alebo ak ho chceme do snimky pridat ako nezavisly objekt,

v hlavnej ponuke zvolime Vlozit' > Polia a v podponuke zvolime jeho pozadovany typ. Ak chceme
pole v snimke upravit, postupujeme podla hdvodu v kapitole 3, Pridavanie a formatovanie textu

v knihe Navod na pouZivanie programu Impress (Impress Guide).

V programe Impress mdzeme pouzit' tieto polia:
* Déatum (pevny)
* Datum (premenny): po otvoreni stiboru sa automaticky aktualizuje
e Cas (pevny)
» Cas (premenny): po otvoreni stiboru sa automaticky aktualizuje
* Autor: meno a priezvisko uvedené v pouzivatelskych tdajoch LibreOffice
 Cislo snimky
* Pocet snimok
* Nazov suboru.

Udaje o autorovi méZeme upravit v hlavnej ponuke na karte Nastroje > MoZnosti >

LibreOffice > Udaje o pouzivatelovi.

Format Cisel (1,2,3 alebo a,b,c alebo i,ii,iii, atd) v ¢iselnom poli méZeme upravit tak,
Tip Ze z hlavnej ponuky otvorime okno Format > Strana, a v iom na karte Strana

v oblasti Nastavenia rozloZzenia zmenime hodnotu v poloZzke Format.

Styl odsekov mdzeme zmenit v okne Styly a forméatovanie, kde upravime prislusny
syl
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Pridavanie poznamok do prezentacie

V programe Impress mozno vkladat poznamky podobne ako v programoch Writer a Calc.

V rezime Normalne zobrazenie vytvorime prazdnu poznamku tak, Ze v hlavnej ponuke zvolime
Vlozit' > Poznamka (obrazok 33). V lavom hornom rohu snimky sa vytvori znacka s inicialkami
autora a stcasne sa vedla neho otvori vacSie textové pole. Impress do textového pola automaticky
vloZi meno autora a datum.

Toto je ukazka poznamky, ktorl mozete
pridat’ do svojej prezentacie |

B Tulne

Poddarknu

u
&8 Preskrinuté

5 Vlodt

&I Zmazat poznamku

fmazat vietky poznamky od Roman Toman

T
]
1

EI] Zmazat' vietky poznamky

Obrazok 33: Vkladanie komentarov

Do textového pola napiSeme alebo vloZime text. Forméat poznamky moZzno upravit tak, Ze v nej
vyberieme text, kliknutim pravym tlacidlom mysi otvorime kontextovu ponuku, a z nej zvolime
pozadovany format. Toto ponuka umoZzni aj zmazanie aktuéalnej poznamky, vSetkych poznadmok
toho istého autora a poznamok v3etkych autorov.

Znacku poznamky mézeme presunut na lubovolné miesto v snimke. Obvykle ho presuvame na
miesto blizko objektu, s ktorym savisi.

Poznamku mézeme zobrazit' alebo skryt pomocou Zobrazit' > Poznamky.

Meno, ktoré sa zobrazuje v poznamke, mdZeme upravit na karte Nastroje > MoZnosti > Udaje
0 pouzivatel'ovi.

Ak dokument upravovali viaceri autori, kazdému z nich sa automaticky priradi ina farba pozadia
poznamky.

Uprava postupnosti snimok a prechodov medzi snimkami

Ako bolo spomenuté v ¢asti ,Uprava prezentacie* na strane 23, Impress na zobrazovanie snimok
prezentacie pouZziva vSeobecne prijatelné predvolené nastavenia, pricom vSak umoznuje Upravu
mnohych detailov. V tejto Casti sa budeme venovat len niektorym aspektom, pricom podrobnejSie
vysvetlenie sa nachadza v kapitole 9, Prezentacie v knihe Navod na pouZivanie programu Impress
(Impress Guide).

Na vacsinu celkovych Uprav prezentéacie je vhodné zobrazenie Zoradovac snimok, kde vidime
naraz viacero snimok. Do neho sa dostaneme bud pomocou volby hlavnej ponuky Zobrazit’ >
Zorad'ova€ snimok alebo kliknutim na zaloZzku Zoradovac snimok v hornej €asti pracovného
priestoru.

Uprava postupnosti snimok a prechodov medzi snimkami 39



Jedna sada snimok - viaceré prezentacie

Casto sa stava, Ze snimok mame viac, ako dokazeme v ur¢itom ase odprednasat, alebo chceme
predniest’ len rychly prehlad bez dérazu na detaily. Namiesto toho, aby sme na takuato prilezitost
vytvarali novu prezentaciu, méZeme pouzit nastroj na skryvanie snimok a nastroj na vytvaranie
upravenych verzii prezentacii.

Skryvanie snimok
1) V paneli Snimky alebo v zoradovaci snimok vyberieme snimky, ktoré chceme skryt.

2) V hlavnej ponuke zvolime Prezentacia > Skryt’ snimku alebo pravym tlacidlom mysi
klikneme na miniataru snimky a v kontextovej ponuke zvolime Skryt’ snimku. Skryté
snimky su preskrtnuté diagonalnymi Ciarami.

Upravené verzie prezentacie

Ak chceme vytvorit upravenu verziu prezentacie pri su¢asnom zachovani pévodnej prezentécie:
1) Vyberieme snimky, ktoré maju byt stcastou modifikovanej verzie.
2) V hlavnej ponuke zvolime Prezentacia > Verzie prezentacie.

3) Klikneme na tlacidlo Nov4, ¢im vytvorime novu sekvenciu snimok a zadame jej nazov.
Z jednej prezentacie mdézeme vytvorit l[ubovolné mnoZstvo upravenych verzii.

Prechod medzi shimkami

Prechod medzi snimkami je kratka animacia, ktoré sa prehra pri prechode zo snimky na

nasledujicu snimku. Styl prechodu méZzeme upravit v paneli Gloh v ¢asti Prechod medzi snimkami.
1) V hlavnej ponuke zvolime Prezentacia > Prechod medzi snimkami alebo klikneme na

*
=l

. - = D ] . :
ikonu Prechod medzi snimkami —= v postrannom paneli, ¢im zobrazime moZzZnosti pre

prechody snimok.

2) Tam zvolime pozadovany Styl prechodu, rychlost’ animécie, a to, i sa nova snimka ma
zobrazit' po kliknuti mySou (preferované) alebo automaticky po uplynuti zadaného ¢asu.

3) Po nastaveni prechodu bud klikneme na Pouzit’ pre vSetky snimky alebo pokracujeme
v nastavovani prechodov pre dalSie snimku v prezentacii.

V Casti Prechod medzi snimkami sa hachadza uzitocné volba Automaticky nahlad.

Tip Ak je zaSkrtnutd a prechod medzi snimkami upravime, prechod sa zobrazi.

Prechod na d'alSiu shimku
V Casti Prechod medzi snimkami v paneli Ulohy méZeme nastavit automaticky prechod na
nasledujicu snimku po uplynuti uréeného casu.
1) V Casti Prechod na d'alSiu snimku zaSkrtneme moznost Automaticky po.
2) Potom zadame Cas v sekundéach, ako dlho sa ma kazda snimka zobrazovat.
3) Ak chceme, aby sa vSetky snimky zobrazovali rovnako dlho, klikneme na tlacidlo Pouzit’
pre vSetky snimky.
Ak chceme pre snimky nastavit r6znu dobu zobrazenia:
1) Prezentéciu spustime pomocou Prezentacia > VyskusSat' €asovanie v hlavnej ponuke.

2) Ak sme pripraveni prejst na nasledujdcu snimku, mySou klikneme na snimku alebo
stlac¢ime klavesu Sipka vpravo alebo medzernik.
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3) Impress si Casovanie pre jednotlivé snimky zapamata a automaticky ich pouZzije po
spusteni prezentacie.
Ak chceme, aby sa prezentacia po poslednej snimke opéatovne spustila:
1) V hlavnej ponuke zvolime Prezentacia > Nastavenia prezentacie.
2) Zaskrtneme Automaticky a nastavime dizku prestavky medzi opakovaniami prezentacie.
3) Nastavenie potvrdime kliknutim na OK.

Spustenie prezentacie
Prezentaciu mdéZeme spustit’ nasledujucimi spésobmi:
* V hlavnej ponuke klikneme na Prezentacia > Zacat' od prvej snimky.

* Klikneme na ikonu Za€at’ od prvej snimky |_;,-ﬂ,§_| na paneli Prezentacia.
e StlaCime klaves F5.

Ak je pre prechod medzi snimkami zaSkrtnutd moznost Automaticky po X sek, snimka sa po
uplynuti nastaveného ¢asu automaticky vymeni.

Ak je zaSkrtnuté Pri kliknuti mySou, na prechod medzi snimkami mame tieto moznosti:
» Sipkami na klavesnici mézeme prejst na nasledujlcu alebo predchadzajicu snimku.
¢ Kliknutim mySou prejdeme na nasledujicu snimku.
¢ StlaCenim medzernika prejdeme na nasledujdcu snimku.

Ak na plochu snimky klikneme pravym tlaCidlom mysi, otvori sa kontextova ponuka, pomocou
ktorej mb6Zeme prejst na lubovolnd snimku a mézeme nastavit' viaceré moznosti.

ReZim prezentéacie mdZzeme kedykolvek (aj po poslednej snimke) ukoncit' stla¢enim klavesu Esc.

Aktudlny snimok (1 z 6) Hasledujicl snimok
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Obrazok 34: Obrazovka prednasajticeho programu Impress
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Obrazovka prednasajuceho

LibreOffice Impress je Standardne vybaveny modulom Obrazovka prednaSajuceho, ktory mozno
pouzit, ak je k pocitaCu pripojeny dodatocny displej. Obrazovka prednaSajliceho (obrazok 34)
poskytuje dalSie moznosti na ovladanie prezentacie poc€as prednasky prostrednictvom odliSného
zobrazenia na obrazovke pocitaca a na displeji, ktory vidi publikum. Na obrazovke pocitata sa
zobrazuje aktualna snimka, nasledujica snimka, poznamky aktualnej snimky a ¢asovac
prezentécie.

Viac informacii o pouZiti Obrazovky prednasajuceho najdeme v kapitole 9, Prezentacie v knihe
Navod na pouZivanie programu Impress (Impress Guide).

Uprava postupnosti snimok a prechodov medzi snimkami
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